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About These Release Notes

This manual contains release notes for the production release of PrecisionTM RTL Synthesis 
Release 2003a Update1. This manual also serves as a repository for PrecisionTM RTL Synthesis 
releases notes as they accrue over time.

From the time this document is published to the present, new information may have become 
available. Please refer to the following web-based documents for the most current information.    
http://www.mentor.com/precision/download
Precision RTL Synthesis Release Notes Manual,  vii
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Chapter 1
Introduction

Precision RTL Synthesis
Precision RTL Synthesis is a synthesis platform that maximizes the performance of both, 
existing programmable logic devices (CPLDs and FPGAs) and next-generation, multi-million 
gate field programmable system-on-chip (FPSoC) devices. Precision RTL Synthesis is a 
comprehensive tool suite, providing design capture in the form of VHDL and Verilog entry, 
advanced register-transfer-level logic synthesis, constraint-based optimization, state-of-the-art 
design analysis, schematic viewing and encapsulated place and route. Precision RTL Synthesis 
runs on Windows 98/NT/2000/XP; and UNIX Sun and HP platforms.

Note: For more information on the Precision RTL Synthesis standard features, options, and  
highlights refer to Chapter 1 in the Precision RTL Synthesis User's Manual.

System Installation
Refer to the Precision Synthesis Installation Guide for complete installation information.
Precision RTL Synthesis Release Notes Manual,  1-1
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Chapter 2
Release 2003a Update1

Customer-Reported Defects Fixed
In this update, the following customer-reported defects have been fixed:

Precision RTL Defects Fixed

dts0100122792 Precision removes black boxes

dts0100123267 Ungroup is causing Precision to not produce an EDIF

dts0100123246 Using (others=>'0') clause in component port mapping causes an error in 
compile

dts0100123278 Precision crashes during compile

Precision Physical Defects Fixed

dts0100121924 MGS_Design::get_tnm crashes when it finds an unconnected output pin

dts0100120798 crash in get_tnm -net

dts0100124830 Crash: Processing UCF File

dts0100121207 UCF2MGC:Error out when ucf instance contains char"-"

dts0100121111 Memory leak in report_timing
Precision RTL Synthesis Release Notes Manual, 2002d update1 2-3
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Chapter 3
Release 2003a

From the time this document is published to the present, new information may have become 
available. Please refer to the following web-based release notes for the most current 
information.     http://www.mentor.com/precision/download

Platform and FPGA Vendor Software 
Compatibility

This release is compatible with the following software and platform configurations:

• Platforms: PC NT/2000/XP; SUN Solaris 5.8; HP 11; Linux Redhat 7.3

• Vendor Place and Route Software: Xilinx ISE 5.2i SP1; ALTR Quartus II 2.2 sp1; 
LATTICE ispLever 3.0; ACTEL Designer R1-03

Release Highlights
Precision RTL 2003a enhancements include the following highlights. Further details are 
contained in these release notes.

 Quality of Results and Controllability Improvements 

• (All FPGA Vendors) Group/ungroup ASIC flow-style hierarchy control for incremental 
improvements in quality of results and ease of migrating designs from 
LeonardoSpectrum L3 flows to Precision flows

• (All FPGA vendors) Improved finite state machine control (FSM encoding algorithm 
manual override)

• (Altera and Xilinx users) Retiming optimization option that can improve design 
performance by up to 50%; Enhanced Register IO mapping

• (Xilinx users) Improved RAM inference
Precision RTL Synthesis Release Notes Manual, 2003a 3-1
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Release Highlights Release 2003a
• (Altera) Enhanced Stratix device family support for MULT, MAC and RAM 
inferencing 

• (Actel users) Radiation Hardened optimization support and updated timing models for 
improved timing correlation and accuracy

Expanded FPGA Vendor Device Support: 

• (Lattice) Added ispMACH4000V family and updated device information for ispGDX2 
devices 

• (Xilinx) Virtex-II ProX, Spartan 3 device families; Added GT10 component support to 
Virtex-II Pro, added intelligent support for new differential signaling clock pads made 
available in ISE5.2i SP1. Continued to add most recent device family support

• (Altera) Enhanced Cyclone support to add EPIC4 devices; IO standard support for 
Stratix/GX, Cyclone, and APEX families 

 User Productivity Improvement

• (Xilinx users) New Xilinx UCF constraints flow for faster timing closure and improved 
timing correlation between synthesis and Xilinx Place and Route tools

Improvements for Military/ AeroSpace / High reliability 
applications: 

• Support for Actel RADHard Optimization

• Ability to create “safe Finite State Machines”

Expanded Platform Support: 

• Linux Redhat 7.3

With this release Mentor Graphics provides production quality Linux support.
Precision RTL Synthesis Release Notes Manual, 2003a3-2
   



Release 2003a New Features
New Features

Mentor Graphics Licensing Upgrades to FLEXlm 8.2

The Mentor Graphics Licensing System has upgraded to Version 8.2 of FLEXlm. The 
supported licensing deamon is mgcld. You should update your license servers with this new 
deamon. The updated license server will continue to support all the older applications without 
any modification, however, an application using this updated version will not be able to acquire 
licenses from servers using older versions of FLEXlm. Additionally, new options have been 
added to the FLEXlm utility tools. For more information on the MGLS changes, refer to the 
document titled Release Notes for Licensing Mentor Graphics Software. For details on the 8.2 
version of FLEXlm, refer to the FLEXlm End User Manual. These manuals can be accessed 
from the pulldown menu Help > Open Manuals Bookcase. For additional help, refer to the 
SupportNet knowledgeBase TechNote mg.51041.

Altera and Xilinx Quality of Results Improvement 
(Register Retiming)

Precision RTL Synthesis includes an option to invoke a powerful optimization algorithm called 
register retiming for improving performance in FPGA designs. Retiming allows the optimizer 
to move registers across combinatorial logic to improve circuit performance in situations where 
tight timing constraints exist. Improvements of up to 50% for Altera and Xilinx designs are not 
uncommon when using this algorithm.

Performing register retiming on a design will not change the functionality at the primary ports 
but may effect the observability of internal registers during post-synthesis simulation. For this 
reason, register retiming is an option that you can select to use prior to synthesizing your design. 
The option is not enabled by default; you must select Retiming through the Tools Set 
Options… Optimization dialog box. If observing internal registers during gate-level 
simulation is not an issue, you can feel comfortable enabling register retiming to solve timing 
issues. For more information on the retiming option, refer to the Precision RTL Synthesis Users 
Manual.

Altera Stratix Quality of Results

For Altera Stratix designs, Precision RTL now automatically chooses to use (infers) Multipliers, 
MACs and RAM memories when it deduces that these large FPGA elements are the best and 
most efficient way to implement your design. This can greatly improve the area and speed of 
your design.
Precision RTL Synthesis Release Notes Manual, 2003a 3-3
   



New Features Release 2003a
State Machine Optimization Control (Safe State 
Machines, State encoding algorithm manual override)

Precision RTL now provides you with greater control over how state machines are 
implemented. This may be important to you if you are building high reliability designs.   
Precision RTL now provides you with the option to 

• specify which state machine encoding algorithm you want the tool to use (for example 
“One Hot”)

• generate a “Safe” state machine. A safe state machine is a state machine in which a 
transition will always be to a valid state. Although state machine optimization will 
create a design which contains only valid transitions under normal circumstances, in 
safety critical situations where radiation could potentially change one of the bits, it is 
important to know that the state machine will recover at the next clock step into a valid 
state. 

Safe FSM operation can be selected either from the GUI as shown below or by using attributes 
in your Verilog or VHDL source code. For more details on State Machine extraction and 
synthesis, refer to the Precision RTL Synthesis Style Guide.

Select FSM Encoding

Click for Safe FSM 
Precision RTL Synthesis Release Notes Manual, 2003a3-4
   



Release 2003a New Features
Group and Ungroup Feature for Greater Controllability 
of Your Design Hierarchy and Improved Quality of 
Results

Precision RTL Synthesis now allows you to manipulate and control your design hierarchy using 
the group/ungroup commands. This feature allows you to dissolve hierarchy (merge more than 
one logical block into a single block) or create new hierarchy (split a logical block into more 
than one block). After doing so, you can re-optimize the new block or blocks created to improve 
results. In general, you will only need to use the group/ungroup features if your design is for 
some reason not meeting its performance or utilization objectives and you wish to manually 
control portions of the design that are to be incrementally improved.   However, in the cases 
where you wish to group or ungroup hierarchy, you must follow these rules. To use this 
capability, do the following: 

1. Invoke group/ungroup from the Precision command line interface or alternatively source 
group/ungroup commands from a script file (using the GUI “run script” command). 
There is no graphical user interface support for group/ungroup.

2. Grouping and ungrouping hierarchy should be performed after all design constraints 
have been applied and the design has been compiled. This will guarantee that the 
hierarchical references in the constraints remain valid when you recompile and 
incrementally synthesize the design.

3. Save your group/ungroup commands to a command file. Please note that these 
commands are not automatically saved into the project SDC file if you type them into 
the Precision RTL command line window. To save the group/ungroup operations 
performed, you must create a command file by selecting File > Save Command File. 
This file can then be edited to reuse the group/ungroup commands later, for example, as 
a script that is sourced using the File > Run Script... menu item.

For more detailed information of the use of the group/ungroup commands, refer to the Precision 
Synthesis Reference Manual.
Precision RTL Synthesis Release Notes Manual, 2003a 3-5
   



New Features Release 2003a
Automatic Detection of RTL “Top Level” Design File

Precision RTL Synthesis no longer requires that the top-level design file be placed at the end of 
your Input File List. After you have compiled the design, Precision will automatically detect the 
design top-level module file and create implementation folders and output files based on the 
top-level entity or module name. Precision will also allow design files to be arranged in the 
Input File List in any order, with the only exception being that VHDL packages must be placed 
before the files that reference them in the Input File List. If multiple design tops exist, Precision 
will select the last top read in the Input File List. After you compile the design, you can 
designate a top file in the GUI by right clicking on the Input Files folder, or individual input file, 
and then select the “Select Top of Design” menu option as shown in the picture below.
Precision RTL Synthesis Release Notes Manual, 2003a3-6
   



Release 2003a New Features
No Need to Specify Clock when Setting Input/Output 
Port Constraints on Buses

Precision Synthesis now allows you to set input/output port constraints on buses or ports folders 
without having to specify a clock. If the clock is not specified, the clock will default to “auto-
select” and Precision will select the appropriate clock for generating the constraint. You need 
only to specify the input or output delay.

Actel Radiation-Hardened Implementation Support

Precision RTL has been enhanced to better support Actel RADHARD methodologies and 
implementations

Actel recommends and Precision RTL now fully implements three techniques for creating the 
logic of sequential elements in radiation-hardened FPGAs: Combinatorial-Combinatorial (C-C), 
Triple Mode Redundancy (TMR), and Triple Mode Redundant C-C (TMR_CC).
Precision RTL Synthesis Release Notes Manual, 2003a 3-7
   



New Features Release 2003a
Combinatorial-Combinatorial (C-C)

The C-C technique provides a way to avoid using the radiation-soft S-module flip-flop by 
combining two combinatorial cells with feedback. For example, a DFP1 (comprised of two 
combinatorial modules) would be used in place of a DF1_CC macro.

Triple Mode Redundancy (TMR)

TMR is an acronym for triple-module-redundancy (or triple voting). It is a register 
implementation technique; each register is implemented by three flip-flops (or latches) that 
“vote” to determine the state of the register.

Triple Mode Redundant C-C (TMR_CC)

TMR_CC is also a triple-module-redundancy technique. Each voting register is composed of 
combinatorial cells with feedback (instead of flip-flop or latch primitives).

Steering Synthesis to use Radiation Hardened Implementations 

To chose which method you want Precision RTL to use, set a “radhardmethod” attribute either 
on the reg/signal being driven by the flip-flop, the flip-flop instantiation itself, or on an entire 
module instantiation. Please see the TCL constraint example below. 

A radiation-hardened implementation can also be set globally for the entire design by issuing 
the following command:

setup_design –radhardmethod=<one of “cc”, “tmr”, “tmr_cc”, or “none”>

The values that are valid for the radhardmethod attribute are identical to those recognized by the 
setup_design switch. Note that while attribute values are not case sensitive, setup_design 
switches are.
Precision RTL Synthesis Release Notes Manual, 2003a3-8
   



Release 2003a New Features
Example TCL constraint:

# Setting attribute on a flop in a TCL file refers to the flop itself
set_attribute -name radhardmethod -value tmr_cc -instance U1/reg_dataout

# Setting attribute on a module
set_attribute -name radhardmethod -value tmr -instance U2

# Setting rad hard method for the entire design
setup_design –radhardmethod=cc

Example Verilog Code:

// Setting the attribute on a reg through a Verilog synthesis directive

reg [7:0] dataout;

// pragma attribute dataout radhardmethod tmr_cc;

// Setting the attribute on an instantiated module
// through a Verilog synthesis directive

// pragma attribute U2 radhardmethod tmr;

Example VHDL Code:

-- Setting the attribute on a registered signal through a VHDL attribute
--
attribute radhardmethod : string;
attribute radhardmethod of dataout: signal is “tmr_cc”;

signal dataout : std_logic_vector(7 downto 0);
--
-- Setting the attribute on an instantiated module
-- through a VHDL attribute
--
attribute radhardmethod : string;
attribute radhardmethod of U2: label is “tmr”;
Precision RTL Synthesis Release Notes Manual, 2003a 3-9
   



New Features Release 2003a
Using the GUI to Set the RadHardMethod Attribute on an Object

You set the RadHardMethod Attribute by right-clicking on the design object in the Precision 
RTL Synthesis hierarchy browser, and selecting “Set Attributes…”

Under the User Attributes field, click on the New button and, as shown below, enter 
“radhardmethod” as the attribute name and set its value appropriately.
Precision RTL Synthesis Release Notes Manual, 2003a3-10
   



Release 2003a New Features
Altera Multicycle Path and False Path Constraint 
Support

Precision RTL Synthesis now supports multicycle path (MCP) attributes and false path 
attributes for Altera technologies, so that your timing reports reflect accurate timing results and 
identify true critical paths. The –from and –to MCP switches are also supported within these 
commands so that you can uniquely specify the exact false or multicycle path.

Precision allows you to specify multicycle or false paths between the following sets of objects:

• Port to instance

• Instance to port

• Instance to instance

Precision propagates these attributes by writing them in the Quartus-II Tcl file.

Since these attributes are applied on a point-to-point basis, they have to be set in the command 
line (after Compile).

set_multicycle_path “# cycles” –from “instance/port” –to “instance/port”
set false_path –from “instance/port” –to “instance/port”

Altera Timing Driven IOB Mapping

Precision now supports “Timing Driven IOB Mapping” for the Altera's Stratix and Cyclone 
family devices. By default, candidate registers are mapped into the IOE as long as they still 
satisfy the register to register timing. The advantage of doing the IOB mapping is to increase the 
availability of the device's internal registers (registers in the LEs) for other synchronous 
applications and also the reduced setup time and clock-to-out time. You can selectively unset 
the mapping by applying the map_complex attribute on individual ports or buses.

The following TCL command unsets the IOB mapping on a bus named accum_out

set_attribute -name map_complex -value false -port accum_out(*)

The "*" character is used as a wild card to represent the bus elements.
Precision RTL Synthesis Release Notes Manual, 2003a 3-11
   



New Features Release 2003a
Change from Xilinx NCF File to Xilinx UCF File 
Constraints

Precision Synthesis now automatically generates a Xilinx UCF file after synthesis, rather than 
an NCF file. The reason is that NCF files can only constrain portions of the design that exist in 
your top-level EDIF file. Constraints for IP cores, or coregens, cannot therefore be specified 
adequately in NCF format. Constraints in the UCF file are applied after the entire design is input 
and linked. So the capabilities of the UCF file are a superset of those of the NCF file. 

Using just UCF files in place of NCF also standardizes the passage of constraints from Precision 
and from other tools around a single format – UCF. This avoids confusion or conflicting 
constraints being passed to ISE place and route – In some situations UCF constraints not 
derived from Precision overrode the NCF constraints that Precision generated and the intent of 
these NCF constraints were therefore ignored by the ISE place and route tools, unbeknownst to 
the user.

Integrated IO Control for Altera and Xilinx

Precision Synthesis now allows you to set port attributes to control its IO properties - standard, 
slew rate and drive strength capabilities and pass this information on to the Place and Route 
tool. This feature is available for Xilinx and Altera technologies. Once set, Precision will 
propagate these attribute values to the respective place and route tools so that the correct IO 
information is used in place and route.

These attributes can be set both via the Precision GUI and also as attributes in the your HDL 
(Verilog or VHDL) code. For setting this attribute in the GUI mode, right click on the Ports 
folder and choose Set Input/Output Constraint. Assign the required IO standard, slew and drive 
by choosing from the pull-down menu.

Xilinx Differential Signaling Clock Buffer Support

Precision Synthesis supports new differential signaling clock buffers with differential outputs 
for advanced high-speed memory interfacing, including automatically adding the necessary 
global clock buffers such that the pad cell drives matched resources as recommended by Xilinx. 

Xilinx Virtex-II Pro 3.3V LVCMOS IO Support

Precision Synthesis now supports use of the 3.3V LVCMOS IO standard recently added to the 
Virtex-II Pro product offering through the use of SelectIO attributes. The user selects these IOs 
using the IO_STANDARD attribute.
Precision RTL Synthesis Release Notes Manual, 2003a3-12
   



Release 2003a New Features
Xilinx Asynchronous Register Support

Precision Synthesis supports passing the async_reg attribute either from the VHDL source 
code, or applied as an attribute on registers through a constraint file or script. A register tagged 
with this attribute will be modeled such that if a timing violation occurs during post-layout 
simulation, it retains its previous value instead of propagating an ‘X’. This attribute is passed to 
Xilinx so that X propagation is disabled for asynchronous registers to prevent simulation 
failures.

New Xilinx Flip Flop Mapping Algorithm for IO 
Registers

This capability allows you to selectively trade off product performance on and off chip. By 
default, Precision RTL Synthesis creates a design by implementing boundary flop flops as part 
of the chip IO Blocks where ever possible, regardless of the design’s desired clock frequency. 
This includes transforming inverted inputs and outputs to normal flip flops with inverted reset 
states. New attributes have been added to allow you to disable this mapping on a flop-by-flop 
and IOB-by-IOB basis. This functionality is available for the following Xilinx device families: 
Virtex, Virtex-E, Virtex-II, Virtex-II Pro, Spartan-II, Spartan-IIE, and Spartan-III devices.

To use, set one of the following three new Precision Synthesis attributes to false:

Inff     (FOR INPUT PORTS)
Outff   (FOR OUTPUT PORTS)
Triff    (FOR TRISTATE PORTS)

It is only necessary to set these attribute values on those flip flops that you do not want mapped 
into the IOB (by setting the appropriate inff, outffF, or triff attribute to false).

You can set these attributes as part of a script by using commands of the following format in 
your SDC constraints file:

set_attribute -name inff -value false -port <port_name>

set_attribute -name outff -value false -port <port_name>

set_attribute -name triff -value false -port <port_name>
Precision RTL Synthesis Release Notes Manual, 2003a 3-13
   



Customer-Reported DRs Fixed Release 2003a
Customer-Reported DRs Fixed
DR329428 Precision Synthesis unable to properly link EDIF input files.

DR331589 Customer design causes Precision to generate an out of memory error.

DR333540 Precision Synthesis fails to generate correct VHDL output for simulation of 
customer design.

DR329428 Precision Synthesis unable to properly link EDIF input files.

DR331589 Customer design causes Precision to generate an out of memory error.

DR333540 Precision Synthesis fails to generate correct VHDL output for simulation of 
customer design.

DR333996 Precision Synthesis abnormally terminates on customer design.

DR334165 Precision Synthesis claims to run out of room in a targeted Virtex-II device before it 
actually does.

DR334345 Precision Synthesis results don’t match customer’s expectations after Quartus II 
P&R.

DR334538 Precision Synthesis improperly mapping to I/O flip flops in Stratix device.

DR334826 Using an improper coding style for RAM inferencing causes Precision Synthesis to 
crash. Precision should issue a warning message instead.

DR334926 Precision Synthesis fails to write a blackbox netlist because the design contains no 
gates.

DR335366 Precision Synthesis autowrite not working properly on customer design.

DR335895 Precision Synthesis unable to read netlist that was written by the Precision netlist 
writer.

DR336322 Precision Synthesis fails to implement TMR on some flip flop when targeting Actel 
ACT2RT device.

DR337164 Precision Synthesis creates incorrect FSM logic for customer design.

DR338594 Precision Synthesis abnormally terminates on customer design while exercising the 
retiming algorithm.

DR338614 Precision Synthesis incorrectly infers a selcounter for a customer design.
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Release 2003a Customer-Reported DRs Fixed
DR338688 Precision Synthesis abnormally terminates when customer’s Stratix design is 
synthesized without IO pads.

DR338913 Precision Synthesis abnormally terminates on customer design during the compile 
phase.

DR338934 Precision Synthesis generates a design that is way larger than expected.

DR339076 Precision Synthesis generates an unrecognizable value for the Xilinx FACTORY_JF 
attribute.

DR339080 Customer unable to complete place and route with LogicLock flow.

DR339258 Precision Synthesis abnormally terminates on customer design after a large number 
of pin constrains are entered via the GUI.

DR339615 Precision Synthesis abnormally terminates on customer design during Advanced 
FSM optimization.
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Chapter 4
Release 2002d update1

Customer-Reported Defects Fixed
In this update, the following customer-reported defects have been fixed:

DR336322 The Precision Synthesis ACT2RT library fails to implement TMR on some flip-
flops.

DR336651 Unsupported Verilog 2001 functions $signed() and $unsigned() generate an unclear 
error message which could cause the user to overlook a possible bad logic issue.

DR337010 Precision RTL Synthesis produces incorrect results for a customer design.

DR337164 Precision RTL Synthesis produces incorrect results for a customer design.
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Chapter 5
Release 2002d

From the time this document is published to the present, new information may have become 
available. Please refer to the following web-based release notes for the most current 
information.    http://www.mentor.com/precision/download

New Features
Precision RTL Synthesis is focused on delivering 1) An Intuitive User Interface, 2) Excellent 
Quality of Results, and 3) Advanced Design Analysis capability. The new features of this 
released are highlighted under these three categories.

Intuitive User Interface

Project Management

A new Project Management system has been added that facilitates multiple implementations of 
a design. This new capability enables you to save “snapshot” versions of your design for 
possible restoration later and perform easy "what if?" analysis with various versions of your 
design.

Extended Help from the Transcript Window

The online help system has been extended to provide quick access to command reference 
information from the Transcript window. You can now “double click” on a transcripted 
command to bring up the command reference page on that command.

Verilog 2001

For the third release in a row, Verilog 2001 constructs have been extended. Support for the 
signed shift operator and named parameters has been added.
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Actel and Lattice Integration

You can now review the results of running Actel and Lattice Place and Route tools directly from 
the Precision user interface. This allows you to run a completely integrated synthesis flow 
through the place and route from within the Precision environment.

Excellent Results

Tighter correlation to Place and Route 

The accuracy of pre place and route timing estimates has been greatly improved, providing 
much closer correlation between Precision's PreciseTime Analysis features and post place and 
route reports, saving lengthy design iterations. Note, however, that your pre place and route 
reports may indicate that your design has apparently degraded in performance, compared with 
earlier Precision RTL release timing reports. In benchmarking situations, it is always 
recommended that you judge quality of results from post place and route timing data.

Altera Stratix Retiming

Altera Stratix support has been enhanced by adding a new Retiming feature. This can increase 
performance by up to 15% on designs that benefit from this functionality.

Xilinx RAM Inference

For the third release in a row, Precision's automatic RAM inferencing has been extended, which 
helps to eliminate the time consuming need to manually instantiate memories.

Advanced Design Analysis

Extended SDC Support

This release extends the support of Synopsys Design Constraints to help focus optimization on 
true critical paths for better quality of results. With this release, Precision now supports the 
set_max_delay and set_min_delay exception constraints.
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Release 2002d Precision Physical Synthesis 2002d Highlights
Precision Physical Synthesis 2002d 
Highlights

The 2002d release is the second release of Precision Physical Synthesis. This release focuses on 
further improving the performance of Xilinx Virtex-II and Virtex-E designs that may have been 
constrained outside of the Precision RTL synthesis environments and designs that may have 
been started from within an alternative synthesis tool. 

Xilinx UCF file Constraint Translator

A new UCF to SDC constraint translator has been added that helps convert user design 
constraints added during place and route, to design constraints readable by Precision Physical 
Synthesis. This new feature facilitates better timing correlation between synthesis and place and 
route for faster timing closure.

Customer-Reported DRs Fixed
DR330543 Precision RTL Synthesis does not map memory to ESBs.

DR330733 Precision RTL Synthesis abnormally terminates on a customer design without a 
transcript explanation.

DR330810 Customer design with 3-D arrays on ports causing Precision RTL Synthesis to 
produce an incorrect EDIF netlist for Xilinx.

DR331781 Precision RTL Synthesis stalls on customer design.

DR331921 Virtex-II design fails in synthesize in Precision RTL due to untranslatable nets.

DR332338 Precision RTL Synthesis connecting the wrong bits of a multiplier to the outputs of 
a Virtex-II design

DR332767 Precision RTL Synthesis abnormally terminates while compiling a customer design 

DR332832 Precision RTL Synthesis is incorrectly compiling input files located in different 
source directories.

DR333044 Precision RTL Synthesis abnormally terminates on a customer design during FSM 
extraction.
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Known Issues Release 2002d
Known Issues

EDIF Netlist Issues

Specifying the Correct Bus Format in Xilinx CORE Generator

If you are using the Xilinx CORE Generator to generate a module, make sure that you specify 
the B(m:n) bus format which is compatible with Precision. The Figure below illustrates how to 
set the bus format with the CORE Generator Project > Project Options dialog box.

Figure 5-1. Xilinx CORE Generator Project Options Dialog Box

If Exemplar is selected, the format will be wrong for Precision because it will be a bit-based 
format.

Reference to “Work” Library in EDF File Not Treated Correctly

The current Precision EDIF netlist parser treats a libraryRef of ‘work’ incorrectly. If the 
libraryRef property is set to 'work' then the last EDF file containing the library will always 
completely replace a previous occurrence of the 'work' library. This is not a problem when the 

1. Select

2. Select

3. Click

2. Select

3. Click
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Release 2002d Known Issues
libraryRef property is set to another name. For example, if you are reading multiple EDF files 
with the same libraryRef “work” and the first EDF file contains the module definition called 
“compare” and the second EDF file also has a “compare” but this is a black box definition, then 
“compare” is not properly expanded and remains a black box. An indication of the issue is when 
a large number of instances are not found when reading the XDL file. The work around is to 
change and duplicate libraryRef properties to new names.

LUT Instance as Part of a Black Box Not Treated Correctly

If a LUT instance is part of the black box or a module with a dont_touch attribute, the EDIF 
writer writes out the following: (property EQN (string "()"))". This causes the EDIF reader to 
stop with an Error “invalid LUT equations”. The way to correct this is to edit the EDIF netlist 
and put the following into the equation. (property EQN (string "(IO * !IO)"))".  This will be 
corrected in a future release.
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Chapter 6
Release 2002c

From the time this document is published to the present, new information may have become 
available. Please refer to the following web-based release notes for the most current 
information.    http://www.mentor.com/precision/download

New Features

Improved Quality of Results

This release of Precision RTL Synthesis includes eleven significant QoR enhancements. Areas 
of improvement include improved RTL and RAM Inferencing, IO driver sizing, IOB mapping 
and Virtex and Stratix synthesis. During testing, 30% of the Xilinx designs showed quality 
improvements and 55% of the Altera designs showed quality improvements.

Improved Run Times

Run times for this release show an average 40% improvement. Large hierarchical designs show 
the greatest run time improvement.

Enhanced Verilog 2001 Support

Verilog 2001 support has been enhanced to include the following addition constructs:

• Power (Exponential) Operator

• Automatic Width Extension Past 32 Bits

• Reg Declaration with Initialization

• Signed/Unsigned Parameters
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Support for Altera PLL Clock Propagation

Clocks now propagate through Altera PLL cells, including the clock multiplication and division 
outputs.

Improved Timing Correlation to P&R

As shown below, Precision timing analysis now takes into account the effects of clock skew. 
This improves the correlation to the place and route timing reports.

Critical path #1, (path slack = 2.45):

SOURCE CLOCK: name: clk period: 10.000000
     Times are relative to the 1st rising edge   
DEST CLOCK: name: clk period: 10.000000      
     Times are relative to the 2nd rising edge 

NAME                           GATE                  DELAY    ARRIVAL DIR 
I4_I1_reg_done_rcving_reg/C FDCE                               0.00   up 
I4_I1_reg_done_rcving_reg/Q FDCE                     0.71      0.71   up 
ix297/I0                    LUT2                               0.71   up 
ix297/O                     LUT2                     0.47      1.18   up 
int_obuf/I                  OBUF(LVTTL,SLOW,12)                1.18   up
int_obuf/O                  OBUF(LVTTL,SLOW,12)      5.16   6.34   up 
in (port)                               6.34   up

                            Initial edge separation:      10.00 
                            Source clock delay:      -     1.20                   
                                                    --------- 
                            Edge separation:               8.80 
                            Setup constraint:        -     0.00  
                                                    --------- 
                            Data required time:            8.80 
                            Data arrival time:       -     6.34                         
                                                    --------- 
                            Slack:                         2.46 
Precision RTL Synthesis Release Notes Manual, 2002c6-2
   



Release 2002c New Technologies Supported
New Technologies Supported

Actel Technologies

All Actel technologies including the new “Axcelerator” family of devices are supported.

Lattice Technologies

All Lattice technologies including the new ORCA 4 and ixpXPGA devices are supported.

Altera Cyclone

The following Altera Cyclone devices are supported.

Altera Cyclone Devices

EP1C3 T100C, T144C

EP1C6 T144C, Q240C

EP1C12 Q240C, F324C

EP1C20 F324C, F400C

Speed Grades supported:  6, 7, 8
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Customer-Reported DRs Fixed Release 2002c
Customer-Reported DRs Fixed
DR323866 Precision RTL Synthesis abnormally terminates on customer design.

DR324224 Need to add messages telling why a dialog entry box is greyed-out.

DR328119 Need to connect unused LCELL inputs to a default value.

DR328463 Can’t read EDIF netlist written with Synplicity EDIF writer.

DR328775 Precision “Save > Project” dialog box should provide a default project name.

DR330009 Precision RTL Synthesis abnormally terminates on customer design.

DR330259 Precision inferring wrong reset type in pipelined multiplier.

DR330581 In Precision, Synplify attribute “syn_noclockbuf” turns buffering on instead of off.

DR330585 The colored Info/Warning/Error dots in the Code Browser disappear on recompile.

DR330614 Need a folder under instances in the Design Browser that contains all black boxes.

DR330733 Precision RTL Synthesis abnormally terminates on customer design.

DR330790 Precision RTL Synthesis abnormally terminates on customer design.
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Known Issues

Invalid Input Buffer Choices for Virtex-II/Virtex-II Pro

The Precision GUI currently presents a few invalid input buffer choices for Virtex-II and Virtex-
II Pro technologies. If you assign one of these invalid buffers to an Input Port, Xilinx ISE will 
report an error in Ngdbuild. The input buffers with a drive and slew attribute appended to the 
name are invalid. For example, the buffer IBUF_LVCMOS_25 is valid, however the buffer 
IBUF_LVCMOS_25_F_12 is invalid and the buffer IBUF_LVCMOS_25_S_12 is invalid.

EDIF Netlist Issues

Specifying the Correct Bus Format in Xilinx CORE Generator

If you are using the Xilinx CORE Generator to generate a module, make sure that you specify the 
B(m:n) bus format which is compatible with Precision. The Figure below illustrates how to set 
the bus format with the CORE Generator Project > Project Options dialog box.

Figure 6-1. Xilinx CORE Generator Project Options Dialog Box
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Known Issues Release 2002c
If Exemplar is selected, the format will be wrong for Precision because it will be a bit-based 
format.

Reference to “Work” Library in EDF File Not Treated Correctly

The current Precision EDIF netlist parser treats a libraryRef of ‘work’ incorrectly. If the 
libraryRef property is set to 'work' then the last EDF file containing the library will always 
completely replace a previous occurrence of the 'work' library. This is not a problem when the 
libraryRef property is set to another name. For example, if you are reading multiple EDF files 
with the same libraryRef “work” and the first EDF file contains the module definition called 
“compare” and the second EDF file also has a “compare” but this is a black box definition, then 
“compare” is not properly expanded and remains a black box. An indication of the issue is when 
a large number of instances are not found when reading the XDL file. The work around is to 
change and duplicate libraryRef properties to new names.

LUT Instance as Part of a Black Box Not Treated Correctly

If a LUT instance is part of the black box or a module with a dont_touch attribute, the EDIF 
writer writes out the following: (property EQN (string "()"))". This causes the EDIF reader to 
stop with an Error “invalid LUT equations”. The way to correct this is to edit the EDIF netlist 
and put the following into the equation. (property EQN (string "(IO * !IO)"))".  This will be 
corrected in a future release.

Invoking Quartus II Multiple Times

Invoking multiple Quartus II 2.1 SP1 sessions at the same time may cause one or more of the 
sessions to hang. Mentor Graphics is working with Altera to identify the source of the  problem.

Un-used Ports on Sub-Modules in a Block-Based 
Synthesis Flow will Cause P&R to Fail

If you are using a block-based (bottom-up) synthesis flow and there is an un-used port on one or 
more pre-synthesized blocks, the design will fail in Place and Route. Contact Mentor Graphics 
Customer Support for possible workarounds.
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Chapter 7
Release 2002b

New Features 

Precision Moves to MainWin 4.02

MainWin is the software package that provides a Windows platform on the Unix operating 
system. With this release, Precision RTL Synthesis has moved to MainWin 4.02.

Sun Solaris 7 No Longer Supported

With the move to MainWin 4.02, the Sun Solaris 7 Operating System is no longer supported. 
Precision RTL Synthesis will, however, continue to support Solaris 8, HP-UX 11.00 and 
Windows 98/NT/2000/XP.

Initial Support for Verilog 2001

This release of Precision RTL Synthesis provides initial support of Verilog 2001. The features 
supported are as follows:

• Signed/unsigned

• Comma separated sensitivity list

• Combinational sensitivity list

• Combined port/data type

• ANSI-style port lists
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New Features Release 2002b
New Toolbar STOP Button

A new STOP button has been added to the Toolbar that allows you to halt the execution of the 
Compile and Synthesize commands.

Improved Clock Constraint Dialog Box

A new Clock Constraints dialog box as been added with the following enhancements:

•  Modified field descriptions to reduce confusion

• A new Domain picklist for specifying an available clock domain

• an Editable waveform viewer that clearly displays the clock specification. 

Field descriptions
modified to reduce
confusion

Editable waveform
viewer clearly displays
clock specifications

Available clock
domains provided
in a picklist
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Release 2002b New Features
Xilinx RAM Inferrencing Enhancements

Major work has been completed to enhance the support of Virtex/Virtex-II/Virtex-II Pro RAM 
inferrencing and mapping. The designer can now include a RAM model that infers a variety of 
dual-port and tri-port RAM configurations. Refer to the Chapter 11 - Xilinx Memory Mapping 
in the Precision RTL Synthesis Style Guide for details and coding examples.

Virtex-II Clock Buffering Improvements

Precision RTL Synthesis now does smarter clock buffer insertion. Precision is no longer 
buffering low-fanout internal clocks (fanout < 100) and is limiting the use of global buffers on 
multiple-clock designs. The benefits are improved performance for designs with internal clocks 
and improved place and route run times, especially for designs with more than 8 clocks. When a 
clock is not globally buffered, a warning message is issued to the Transcript.

Virtex-II Multiplier Control

Virtex-II/Virtex-II Pro multiplier implementation can now be controlled by setting a constraint. 
After compiling your design, you can select a multiplier operator, as shown below, and select a 
MULT18x18 (dedicated) implementation or a MULT_AND implementation.
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Virtex Timing-Driven IOB Mapping

Registers that are connected directly to ports are now automatically assigned to the IOB when 
timing is not impacted or when timing is improved. You can override this behavior before 
synthesis by right-clicking on a port in the Design Hierarchy window, as shown below, and 
turning the feature off.

Gated-Clock Support

Clocks are now automatically propagated through internal clock pins during the “compile” 
phase. This means that you can now set clock constraints for gated clocks from the primary 
input port. If you hover the cursor over a propagated clock pin in the Schematic Viewer, the 
query pop-up will display the constraint information.
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New Technologies Supported

Xilinx Virtex-II Pro

Device Support for the Virtex-II Pro Family has been expanded to include the following:

Xilinx Virtex-II Speed Grades

Support for Virtex-II device stepping speed grades -4s1 and -5s1 has been added.

Customer-Reported DRs Fixed
DR327436 Precision calculates the wrong slack for an Altera Stratix device.

DR327546 Precision produces an incorrect netlist on a customer design.

Known Issues

Precision is Not Supported on Solaris 8 Versions 
Released after Dec. 13, 2001

Precision RTL Synthesis is experiencing very long invoke times and very long run times on Sun 
machines with kernel version: SunOS 5.8 Generic 108528-13 December 2001 and later. This 
problem will be resolved in a future release of Precision. You can check the version of the 
Solaris Operating System by using the ‘showrev’ command.

New Virtex-II Pro Devices

2VP30 fg256, ff896, ff1152

2VP70 ff1704

2VP100 ff1704

2VP125 ff1704
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Chapter 8
Release 2002a

Introducing Precision RTL Synthesis
Mentor Graphics Corporation, the leader in programmable logic design solutions is pleased to 
introduce our newest synthesis product, Precision RTL Synthesis. Precision RTL Synthesis is a 
synthesis platform that maximizes the performance of both, existing programmable logic 
devices (CPLDs and FPGAs) and next-generation, multi-million gate field programmable 
system-on-chip (FPSoC) devices. Precision RTL Synthesis is a comprehensive tool suite, 
providing design capture in the form of VHDL and Verilog entry, advanced register-transfer-
level logic synthesis, constraint-based optimization, state-of-the-art design analysis, schematic 
viewing and encapsulated place and route. Precision RTL Synthesis runs on Windows 
98/NT/2000/XP; and UNIX Sun and HP platforms.

Precision RTL Synthesis Technical 
Overview 

Precision RTL Synthesis addresses the requirements of both current and next-generation 
programmable logic design. The synthesis solution features an intuitive graphical user interface, 
a new suite of optimization algorithms (Architecture Signature ExtractionTM) and a state-of-the-
art timing engine (PreciseTime) that delivers the industry's most accurate timing analysis.
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Precision RTL Synthesis Technical Overview Release 2002a
Intuitive Design Flow Eases Next-Generation 
Programmable Device Design 

Precision RTL Synthesis accelerates time-to-productivity for 
both novice and experienced programmable logic designers, 
equipping designers with an intuitive user interface that 
makes achieving design goals easier. At the heart of the 
push-button flow is the Design Center that is driven by the 
design bar and provides two distinct views of the design - 
design view and hierarchy view. 

The Design Bar guides, both novice and expert users alike, 
easily through the synthesis and place and route process. A 
progressive disclosure paradigm presents only valid next 
steps reducing frustration and confusion. When optimization 
completes, additional design bars appear to assist with design 
analysis and vendor place and route. 

Precision's Design Center design view enables designers to 
perform all operations with a click of the mouse, including 
adding or editing design and constraint files, or viewing 
synthesis and place and route report files. The design view 
also provides revision management, enabling designers to 
control design iterations. 

Precision's unique hierarchy view provides a view of the 
compiled design and is directly linked to a schematic viewer, 
enabling designers to find any object in the design and apply 
constraints directly to the object. This eliminates the need to 
launch additional design editors for entering constraints, 
which saves time, increases productivity and eliminates user 
frustration when working with large designs. 
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Precision's flexible constraint entry provides the ability to 
enter constraints from the design center, from the integrated 
schematic viewer, from any text reports as well as from user 
provided scripts. It also leverages industry expertise through 
the support of Synopsys Design Constraint (SDC) for 
specifying timing for the design. 

Precision’s User Interface Features and Benefits

Multiple Design Flows

Designers require flexibility in the way they approach a design. Precision provides two basic 
flows, top-down and block-based. In addition, various vendor-specific advanced design flows 
are supported.

Top-Down Design Flow

Top-down design implies that the entire design is loaded into the synthesis environment and 
optimized at once. Top-down design methodologies are the easiest and generally yield the best 
results by allowing the synthesis tool to perform inter-module optimizations. Precision supports 
top-down design for the largest FPGA devices on the market today and has optimized the user 
interface and optimization algorithms to excel at this flow. 

Feature Benefit

Design Center A single user interface, the design center, provides all the 
control necessary to compile, constrain, optimize, analyze 
and place and route a design

Design Bar Guides designers through the synthesis process without ever 
presenting an invalid step

Project Management Keeps track of input and output files, provides quick access to 
output results and allows users to work with multiple 
revisions

Flexible Constraint Entry Timing constraints can be applied throughout the system 
using a variety of design views

Industry Standard Constraints Allows for easy migration between ASIC and FPGA design 
tools and enables designers to take advantage of most IP

Flexible Flows Design how you want, Top Down or Bottom Up
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Block-Based Design Flow

Block-based or bottom-up design implies that the design is divided along major functional 
blocks and optimized in a piecemeal fashion. This design methodology is more involved but 
provides designers a way to manage the immense amounts of data associated with large designs. 
The largest FPGAs available today offer gate counts in excess of 8 million ASIC gates. 
Precision RTL Synthesis is unique in its comprehensive support for bottom-up design 
methodology for FPGAs. 

Block-Based design features and benefits are summarized in the following table:

Feature Benefit

Optimize blocks without IO 
insertion

Allows sub-blocks to be optimized independent of the top-
level design.

Read / write binary database Allows a pre-optimized sub-blocks to be saved and re-read 
into logic synthesis.

Don't_touch attribute on blocks Prevents re-optimization of previously sub-blocks.
Preserves the integrity of block based verification efforts.

Assembly of final design from 
pre-optimized sub-blocks

Allows design analysis to be performed on entire design prior 
to place and route.
Allows IO buffers to be instantiated.
Allows user to perform additional optimizations if necessary.

Current Design Allows selection of a block from within a top-level design.

Incremental Updates of blocks Allows functional updates to be incorporated into final design 
with minimal re-optimization and re-place and route.
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Advanced Design Flows

Precision RTL Synthesis automatically recognizes Altera's encrypted IP or the unique files 
associated with the Xilinx PCI core and configure the necessary synthesis and place and route 
settings. This automation dramatically reduces the complexity of these flows, including place 
and route. 

A.S.E. Optimization Raises the Bar on Design 
Performance

Precision RTL Synthesis includes a suite of unique 
algorithms called Architecture Signature ExtractionTM (ASE) 
optimization which, based on timing constraints, focuses 
specific optimizations on areas of the design that likely 
hinder overall performance, such as finite state machines 
(FSMs), cross-hierarchical paths, or paths with excessive 
combinational logic. ASE optimization uses an automated, 
heuristic approach to deliver smaller designs that achieve 
project requirements in less time by reducing the manual 
process of isolating and correcting problem areas in a design. 
ASE optimization performs advanced technique tasks such as Look-up Table (LUT) merging, 
logic tunneling, register re-timing and timing-driven I/O block (IOB) mapping to reach the 
target performance without the need for iterative manual user intervention. 

Precision's advanced optimization technology breaks down performance limiting design 
barriers such as register, hierarchy and operator boundaries to provide you with the smallest and 
fastest design possible.

PreciseTime Drives Performance and Provides Rapid 
Design Analysis 

Precision RTL Synthesis includes PreciseTime; an incremental timing engine that provides 
advanced functionality previously found only in stand-alone static timing analysis tools. 
PreciseTime's advanced analysis includes the following:

• RTL Analysis that reports warning and errors in your RTL and traces them back to the 
source code.

• Graphical Analysis so that you can view your design in RTL

• Constraint Analysis to ensure your design is properly constrained

• Area Analysis to ensure your design fits in the desired device
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• Incremental Timing Analysis that reports timing on any pin or port in the design

• Cross-Clock Domain Analysis to ensure that there are no meta-stable clocks

• Mapped schematics that can be filtered to show only critical path fragments

• Cross-probing between schematics, reports and source code

Design Analysis Features and Benefits

Feature Benefit

Language Analysis VHDL and Verilog design templates.
Cross-probing from error messages back to source code.

Constraint Analysis Verifies that a design is fully constrained.
Insures that no critical paths are overlooked.

Clock Domain Analysis Ensures that asynchronous clocks are truly asynchronous.
Eliminates problems from meta-stable clocks.

Critical Path Schematic 
Fragment

Lets designers focus on a small view of important logic in 
their designs.

Fan-in Fan-out Fragment 
Viewing

Allows designers to isolate critical logic for viewing all the 
logic to or from a particular node.
Powerful viewer for viewing clocks or the logical source of a 
node.

Timing Violations Report Constraints without a violation are not displayed.
Provides a list of constraints that have a timing violation.

Incremental Timing Analysis Provides fast “what-if” analysis of design timing.
Change constraints and get new timing information 
immediately.

Generate Timing Reports from 
Schematics

Allows efficient starting point for timing reports.
Gives designers a deep knowledge of their design timing.
If place and route shows a different path, you can easily 
display the same logic.

Timing Report to Schematic 
Cross-highlighting

Quickly reference nets or instances in a timing report to the 
schematic. 
Once located, fan-in and fan-out schematics can be quickly 
located.
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Release 2002a Devices Supported
Devices Supported
This release of Precision RTL Synthesis supports the following Altera and Xilinx families.

Altera Devices Supported

Xilinx Devices Supported

Additional Device Support

Additional Vendor Devices will be supported in upcoming releases.

For a complete list of devices currently supported, refer to Chapter 4 in the Precision Synthesis 
Reference Manual.

Altera Device Families Supported

Stratix

Excalibur ARM

Mercury

APEX II

APEX 20K/20KE/20KC

FLEX 6000/8000/10K

ACEX

MAX

Xilinx Device Families Supported

Virtex-II/Virtex-II Pro

Virtex/Virtex-E

Spartan-II/Spartan-IIE

XC4000/XC5200
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Known Issues Release 2002a
Known Issues

Precision is Not Supported on Solaris 8 Versions 
Released after Dec. 13, 2001

Precision RTL Synthesis is experiencing very long invoke times and very long run times on Sun 
machines with kernel version: SunOS 5.8 Generic 108528-13 December 2001 and later. This 
problem will be resolved in a future release of Precision. You can check the version of the 
Solaris Operating System by using the ‘showrev’ command.

How You Can Learn More...

Context-Sensitive Help

Precision RTL Synthesis provides context-sensitive help throughout the GUI. You can press F1 
to open a context-sensitive help or press the HELP button. The GUI window must be selected 
first to be in current focus when using F1. (Note: F1 is not available for UNIX.)

You can also view frames of help text and graphics by moving your cursor to the Help pulldown 
menu and selecting: Help > Help Contents... You can expand the Table of Contents and select 
from a variety of topics or do a full index search for keywords.

Product Manuals

All Precision RTL Synthesis product manuals are available for on-screen viewing and printing 
with the Adobe Acrobat Reader after Precision RTL Synthesis and the Adobe Acrobat Reader 
are installed. You can view the manuals by selecting the following pulldown menu from the 
Main menu: Help > Open Manuals Bookcase

The PDF manuals and the Manuals Bookcase also contain HyperText links that guide you to 
related vendor documentation on the Web, provided your web browser is operational and 
properly configured. 
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End-User License Agreement

IMPORTANT - USE OF THIS SOFTWARE IS SUBJECT TO LICENSE RESTRICTIONS.
CAREFULLY READ THIS LICENSE AGREEMENT BEFORE USING THE SOFTWARE.

END-USER LICENSE AGREEMENT

1. GRANT OF LICENSE. The software programs you are installing, downloading, or have acquired with this
Agreement, including any updates, modifications, revisions, copies, documentation and design data (“Software”)
are copyrighted, trade secret and confidential information of Mentor Graphics or its licensors who maintain
exclusive title to all Software and retain all rights not expressly granted by this Agreement. Mentor Graphics
grants to you, subject to payment of appropriate license fees, a nontransferable, nonexclusive license to use
Software solely: (a) in machine-readable, object-code form; (b) for your internal business purposes; and (c) on
the computer hardware or at the site for which an applicable license fee is paid, or as authorized by Mentor
Graphics. A site is restricted to a one-half mile (800 meter) radius. Mentor Graphics' standard policies and
programs, which vary depending on Software, license fees paid or service plan purchased, apply to the following
and are subject to change: (a) relocation of Software; (b) use of Software, which may be limited, for example, to
execution of a single session by a single user on the authorized hardware or for a restricted period of time (such
limitations may be communicated and technically implemented through the use of authorization codes or similar
devices); (c) support services provided, including eligibility to receive telephone support, updates, modifications
and revisions. Current standard policies and programs are available upon request.

2. ESD SOFTWARE. If you purchased a license to use embedded software development (“ESD”) Software,
Mentor Graphics grants to you a nontransferable, nonexclusive license to reproduce and distribute executable
files created using ESD compilers, including the ESD run-time libraries distributed with ESD C and C++
compiler Software that are linked into a composite program as an integral part of your compiled computer
program, provided that you distribute these files only in conjunction with your compiled computer program.
Mentor Graphics does NOT grant you any right to duplicate or incorporate copies of Mentor Graphics' real-time
operating systems or other ESD Software, except those explicitly granted in this section, into your products
without first signing a separate agreement with Mentor Graphics for such purpose.

3. BETA CODE. Portions or all of certain Software may contain code for experimental testing and evaluation
(“Beta Code”), which may not be used without Mentor Graphics' explicit authorization. Upon Mentor Graphics'
authorization, Mentor Graphics grants to you a temporary, nontransferable, nonexclusive license for
experimental use to test and evaluate the Beta Code without charge for a limited period of time specified by
Mentor Graphics. This grant and your use of the Beta Code shall not be construed as marketing or offering to sell
a license to the Beta Code, which Mentor Graphics may choose not to release commercially in any form. If
Mentor Graphics authorizes you to use the Beta Code, you agree to evaluate and test the Beta Code under normal
conditions as directed by Mentor Graphics. You will contact Mentor Graphics periodically during your use of the
Beta Code to discuss any malfunctions or suggested improvements. Upon completion of your evaluation and
testing, you will send to Mentor Graphics a written evaluation of the Beta Code, including its strengths,
weaknesses and recommended improvements. You agree that any written evaluations and all inventions, product
improvements, modifications or developments that Mentor Graphics conceives or made during or subsequent to
this Agreement, including those based partly or wholly on your feedback, will be the exclusive property of

This license is a legal “Agreement” concerning the use of Software between you, the end user, either
individually or as an authorized representative of the company acquiring the license, and Mentor
Graphics Corporation and Mentor Graphics (Ireland) Limited, acting directly or through their
subsidiaries or authorized distributors (collectively “Mentor Graphics”). USE OF SOFTWARE
INDICATES YOUR COMPLETE AND UNCONDITIONAL ACCEPTANCE OF THE TERMS AND
CONDITIONS SET FORTH IN THIS AGREEMENT. If you do not agree to these terms and conditions,
promptly return, or, if received electronically, certify destruction of, Software and all accompanying items
within five days after receipt of Software and receive a full refund of any license fee paid. 



Mentor Graphics. Mentor Graphics will have exclusive rights, title and interest in all such property. The
provisions of this subsection shall survive termination or expiration of this Agreement.

4. RESTRICTIONS ON USE. You may copy Software only as reasonably necessary to support the authorized
use. Each copy must include all notices and legends embedded in Software and affixed to its medium and
container as received from Mentor Graphics. All copies shall remain the property of Mentor Graphics or its
licensors. You shall maintain a record of the number and primary location of all copies of Software, including
copies merged with other software, and shall make those records available to Mentor Graphics upon request.
You shall not make Software available in any form to any person other than employees and contractors,
excluding Mentor Graphics' competitors, whose job performance requires access. You shall take appropriate
action to protect the confidentiality of Software and ensure that any person permitted access to Software does not
disclose it or use it except as permitted by this Agreement. Except as otherwise permitted for purposes of
interoperability as specified by applicable and mandatory local law, you shall not reverse-assemble, reverse-
compile, reverse-engineer or in any way derive from Software any source code. You may not sublicense, assign
or otherwise transfer Software, this Agreement or the rights under it, whether by operation of law or otherwise
(“attempted transfer”) without Mentor Graphics' prior written consent and payment of Mentor Graphics then-
current applicable transfer charges. Any attempted transfer without Mentor Graphics’ prior written consent shall
be a material breach of this Agreement and may. at Mentor graphics’ option, result in the immediate termination
of the Agreement and licenses granted under this Agreement. The provisions of this section 4 shall survive the
termination or expiration of this Agreement.

5. LIMITED WARRANTY.

5.1. Mentor Graphics warrants that during the warranty period, Software, when properly installed, will
substantially conform to the functional specifications set forth in the applicable user manual. Mentor
Graphics does not warrant that Software will meet your requirements or that operation of Software will be
uninterrupted or error free. The warranty period is 90 days starting on the 15th day after delivery or upon
installation, whichever first occurs. You must notify Mentor Graphics in writing of any nonconformity
within the warranty period. This warranty shall not be valid if Software has been subject to misuse,
unauthorized modification or installation. MENTOR GRAPHICS' ENTIRE LIABILITY AND YOUR
EXCLUSIVE REMEDY SHALL BE, AT MENTOR GRAPHICS' OPTION, EITHER (A) REFUND OF
TH E P RICE P AID  U PO N RETU RN OF S OFTW ARE TO  M EN TOR GRAP HICS  OR (B)
MODIFICATION OR REPLACEMENT OF SOFTWARE THAT DOES NOT MEET THIS LIMITED
WARRANTY, PROVIDED YOU HAVE OTHERWISE COMPLIED WITH THIS AGREEMENT.
MENTOR GRAPHICS MAKES NO WARRANTIES WITH RESPECT TO: (A) SERVICES; (B)
SOFTWARE WHICH IS LICENSED TO YOU FOR A LIMITED TERM OR LICENSED AT NO COST;
OR (C) EXPERIMENTAL BETA CODE; ALL OF WHICH ARE PROVIDED “AS IS.” 

5.2. THE WARRANTIES SET FORTH IN THIS SECTION 5 ARE EXCLUSIVE. NEITHER MENTOR
GRAPHICS NOR ITS LICENSORS MAKE ANY OTHER WARRANTIES, EXPRESS, IMPLIED, OR
STATUTORY, WITH RESPECT TO SOFTWARE OR OTHER MATERIAL PROVIDED UNDER THIS
AGREEMENT. MENTOR GRAPHICS AND ITS LICENSORS SPECIFICALLY DISCLAIM ALL
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
AND NON-INFRINGEMENT OF INTELLECTUAL PROPERTY.

6. LIMITATION OF LIABILITY. EXCEPT WHERE THIS EXCLUSION OR RESTRICTION OF LIABILITY
WOULD BE VOID OR INEFFECTIVE UNDER APPLICABLE LAW, IN NO EVENT SHALL MENTOR
GRAPHICS OR ITS LICENSORS BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES (INCLUDING LOST PROFITS OR SAVINGS) WHETHER BASED ON
CONTRACT, TORT OR ANY OTHER LEGAL THEORY, EVEN IF MENTOR GRAPHICS OR ITS
LICENSORS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT
SHALL MENTOR GRAPHICS' OR ITS LICENSORS' LIABILITY UNDER THIS AGREEMENT EXCEED
THE AMOUNT PAID BY YOU FOR THE SOFTWARE OR SERVICE GIVING RISE TO THE CLAIM. IN
THE CASE WHERE NO AMOUNT WAS PAID, MENTOR GRAPHICS AND ITS LICENSORS SHALL
HAVE NO LIABILITY FOR ANY DAMAGES WHATSOEVER.



7. LIFE ENDANGERING ACTIVITIES. NEITHER MENTOR GRAPHICS NOR ITS LICENSORS SHALL
BE LIABLE FOR ANY DAMAGES RESULTING FROM OR IN CONNECTION WITH THE USE OF
SOFTWARE IN ANY APPLICATION WHERE THE FAILURE OR INACCURACY OF THE SOFTWARE
MIGHT RESULT IN DEATH OR PERSONAL INJURY.

8. INDEMNIFICATION. YOU AGREE TO INDEMNIFY AND HOLD HARMLESS MENTOR GRAPHICS
AND ITS LICENSORS FROM ANY CLAIMS, LOSS, COST, DAMAGE, EXPENSE, OR LIABILITY,
INCLUDING ATTORNEYS' FEES, ARISING OUT OF OR IN CONNECTION WITH YOUR USEOF
SOFTWARE AS DESCRIBED IN SECTION 7.

9. INFRINGEMENT.

9.1. Mentor Graphics will defend or settle, at its option and expense, any action brought against you alleging that
Software infringes a patent or copyright or misappropriates a trade secret in the United States, Canada,
Japan, or member state of the European Patent Office. Mentor Graphics will pay any costs and damages
finally awarded against you that are attributable to the infringement action. You understand and agree that as
conditions to Mentor Graphics’ obligations under this section you must: (a) notify Mentor Graphics
promptly in writing of the action; (b) provide Mentor Graphics all reasonable information and assistance to
defend or settle the action; and (c) grant Mentor Graphics sole authority and control of the defense or
settlement of the action.

9.2. If an infringement claim is made, Mentor Graphics may, at its option and expense: (a) replace or modify
Software so that it becomes noninfringing; (b) procure for you the right to continue using Software; or (c)
require the return of Software and refund to you any license fee paid, less a reasonable allowance for use.

9.3. Mentor Graphics has no liability to you if infringement is based upon: (a) the combination of Software with
any product not furnished by Mentor Graphics; (b) the modification of Software other than by Mentor
Graphics; (c) the use of other than a current unaltered release of Software; (d) the use of Software as part of
an infringing process; (e) a product that you make, use or sell; (f) any Beta Code contained in Software; (g)
any Software provided by Mentor Graphics' licensors who do not provide such indemnification to Mentor
Graphics' customers; or (h) infringement by you that is deemed willful. In the case of (h) you shall reimburse
Mentor Graphics for its attorney fees and other costs related to the action upon a final judgment. 

9.4. THIS SECTION 9 STATES THE ENTIRE LIABILITY OF MENTOR GRAPHICS AND ITS
LICENSORS AND YOUR SOLE AND EXCLUSIVE REMEDY WITH RESPECT TO ANY ALLEGED
PATENT OR COPYRIGHT INFRINGEMENT OR TRADE SECRET MISAPPROPRIATION BY ANY
SOFTWARE LICENSED UNDER THIS AGREEMENT.

10. TERM. This Agreement remains effective until expiration or termination. This Agreement will automatically
terminate if you fail to comply with any term or condition of this Agreement or if you fail to pay for the license
when due and such failure to pay continues for a period of 30 days after written notice from Mentor Graphics. If
Software was provided for limited term use, this Agreement will automatically expire at the end of the authorized
term. Upon any termination or expiration, you agree to cease all use of Software and return it to Mentor Graphics
or certify deletion and destruction of Software, including all copies, to Mentor Graphics' reasonable satisfaction.

11. EXPORT. Software is subject to regulation by local laws and United States government agencies, which
prohibit export or diversion of certain products, information about the products, and direct products of the
products to certain countries and certain persons. You agree that you will not export any Software or direct
product of Software in any manner without first obtaining all necessary approval from appropriate local and
United States government agencies.

12. RESTRICTED RIGHTS NOTICE. Software was developed entirely at private expense and is commercial
computer software provided with RESTRICTED RIGHTS. Use, duplication or disclosure by the U.S.
Government or a U.S. Government subcontractor is subject to the restrictions set forth in the license agreement
under which Software was obtained pursuant to DFARS 227.7202-3(a) or as set forth in subparagraphs (c)(1)
and (2) of the Commercial Computer Software - Restricted Rights clause at FAR 52.227-19, as applicable.



Contractor/manufacturer is Mentor Graphics Corporation, 8005 SW Boeckman Road, Wilsonville, Oregon
97070-7777 USA. 

13. THIRD PARTY BENEFICIARY. For any Software under this Agreement licensed by Mentor Graphics from
Microsoft or other licensors, Microsoft or the applicable licensor is a third party beneficiary of this Agreement
with the right to enforce the obligations set forth in this Agreement.

14. AUDIT RIGHTS. With reasonable prior notice, Mentor Graphics shall have the right to audit during your
normal business hours all records and accounts as may contain information regarding your compliance with the
terms of this Agreement. Mentor Graphics shall keep in confidence all information gained as a result of any
audit. Mentor Graphics shall only use or disclose such information as necessary to enforce its rights under this
Agreement. 

15. CONTROLLING LAW AND JURISDICTION. THIS AGREEMENT SHALL BE GOVERNED BY AND
CONSTRUED UNDER THE LAWS OF OREGON, USA, IF YOU ARE LOCATED IN NORTH OR SOUTH
AMERICA, AND THE LAWS OF IRELAND IF YOU ARE LOCATED OUTSIDE OF NORTH AND SOUTH
AMERICA. All disputes arising out of or in relation to this Agreement shall be submitted to the exclusive
jurisdiction of Dublin, Ireland when the laws of Ireland apply, or Wilsonville, Oregon when the laws of Oregon
apply. This section shall not restrict Mentor Graphics’ right to bring an action against you in the jurisdiction
where your place of business is located.

16. SEVERABILITY. If any provision of this Agreement is held by a court of competent jurisdiction to be void,
invalid, unenforceable or illegal, such provision shall be severed from this Agreement and the remaining
provisions will remain in full force and effect.

17. MISCELLANEOUS. This Agreement contains the parties’ entire understanding relating to its subject matter
and supersedes all prior or contemporaneous agreements, including but not limited to any purchase order terms
and conditions, except valid license agreements related to the subject matter of this Agreement (which are
physically signed by you and an authorized agent of Mentor Graphics) either referenced in the purchase order or
otherwise governing this subject matter. This Agreement may only be modified in writing by authorized
representatives of the parties. Waiver of terms or excuse of breach must be in writing and shall not constitute
subsequent consent, waiver or excuse. The prevailing party in any legal action regarding the subject matter of
this Agreement shall be entitled to recover, in addition to other relief, reasonable attorneys' fees and expenses.
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Trademark Information
Mentor Graphics Trademarks

The following names are trademarks, registered trademarks, and service marks of Mentor Graphics Corporation:

3D Design, A World of Learning(SM), ABIST, Arithmetic BIST, AccuPARTner, AccuParts, AccuSim, ADEPT, ADVance MS, ADVance RFIC, 
AMPLE, Analog Analyst, Analog Station, AppNotes(SM), ARTgrid, ArtRouter, ARTshape, ASICPlan, ASICVector Interfaces, Aspire 
Assess2000(SM), AutoActive, AutoCells, AutoDissolve, AutoFilter, AutoFlow, AutoLib, AutoLinear, AutoLink, AutoLogic, AutoLogic 
BLOCKS, AutoLogic FPGA, AutoLogic VHDL, AutomotiveLib, AutoPAR, AutoTherm, AutoTherm Duo, AutoThermMCM, AutoView, Autowire 
Station, AXEL, AXEL Symbol Genie, BISTArchitect, BIST Compiler(SM), BIST-In-Place(SM), BIST-Ready(SM), Block Station, Board Architect, 
Board Designer, Board Layout, Board Link, Board Process Library, Board Station, Board Station Consumer, BOLD Administrator, BOLD Browser, 
BOLD Composer, BSDArchitect, BSPBuilder, Buy on Demand, Cable Analyzer, Cable Station, CAECO Designer, CAEFORM, Calibre, Calibre 
DRC, Calibre DRC-H, Calibre Interactive, Calibre LVS, Calibre LVS-H, Calibre OPCpro, Calibre ORC, Calibre PRINTimage, Calibre PSMgate, 
Calibre WORKbench, Calibre RVE, Calibre MGC, CAM Station, Capture Station, CAPITAL, CAPITAL Analysis, CAPITAL Bridges, CAPITAL 
Documents, CAPITAL H, CAPITAL Harness, CAPITAL Harness Systems, CAPITAL H the complete desktop engineer, CAPITAL Insight, CAPITAL 
Integration, CAPITAL Manager, CAPITAL Manufacturer, CAPITAL Support, CAPITAL Systems, Cell Builder, Cell Station, CellFloor, CellGraph, 
CellPlace, CellPower, CellRoute, Centricity, CEOC, CheckMate, CheckPlot, CHEOS, Chip Station, ChipGraph, ChipLister, Circuit 
PathFinder, Co-Verification Environment, Co-Lsim, CodeVision, CommLib, Concurrent Board Process(SM), Concurrent Design Environment, 
Connectivity Dataport, Continuum, Continuum Power Analyst, CoreAlliance, CoreBIST, Core Builder, Core Factory, CTIntegrator, DataCentric 
Model, DataFusion, Datapath, Data Solvent, dBUG, Debug Detective, DC Analyzer, Design Architect, Design Architect Elite, DesignBook, 
Design Capture, Design Only, Design Manager, Design Station, DesignView, DesignWide, DesktopASIC, Destination PCB, DFTAdvisor, 
DFTArchitect, DFTCompiler, DFTInsight, DirectConnect(SM), DSV, Direct System Verification, Documentation Station, DSS (Decision Support 
System), ECO Immunity(SM), EDT, Eldo, EldoNet, ePartners, EParts, E3LCable, EDGE (Engineering Design Guide for Excellence)(SM), Empowering 
Solutions, Engineer’s Desktop, EngineerView, ENRead, ENWrite, ESim, Exemplar, Exemplar Logic, Expedition, Expert2000(SM), Explorer 
CAECO Layout, Explorer CheckMate, Explorer Datapath, Explorer Lsim, Explorer Lsim-C, Explorer Lsim-S, Explorer Ltime, Explorer Schematic, 
Explorer VHDLsim, ExpressI/O, FabLink, Falcon, Falcon Framework, FastScan, FastStart, FastTrack Consulting(SM), First-Pass Design Success, 
First-Pass success(SM), FlexSim, FlexTest, FDL (Flow Definition Language), FlowTabs, FlowXpert, FORMA, FormalPro, FPGA Advantage, 
FPGAdvisor, FPGA BoardLink, FPGA Builder, FPGASim, FPGA Station, FrameConnect, Galileo, Gate Station, GateGraph, GatePlace, 
GateRoute, GDT, GDT Core, GDT Designer, GDT Developer, GENIE, GenWare, Geom Genie, HDL2Graphics, HDL Architect, HDL Architect 
Station, HDL Author, HDL Designer, HDL Designer Series, HDL Detective, HDL Inventor, HDL Pilot, HDL Processor, HDL Sim, Hardware 
Modeling Library, HIC rules, Hierarchical Injection, Hierarchy Injection, HotPlot, Hybrid Designer, Hybrid Station, IC Design Station, IC Designer, 
IC Layout Station, IC Station, ICbasic, ICblocks, ICcheck, ICcompact, ICdevice, ICextract, ICGen, ICgraph, ICLink, IClister, ICplan, ICRT 
Controller Lcompiler, ICrules, ICtrace, ICverify, ICview, ICX, ICX Custom Model, ICX Custom Modeling, ICX Project Modeling, ICX Standard 
Library, IDEA Series, Idea Station, INFORM, IFX, Inexia, Integrated Product Development, Integra Station, Integration Tool Kit, INTELLITEST, 
Interactive Layout, Interconnect Table, Interface-Based Design, IBD, IntraStep(SM), Inventra, InventraIPX, Inventra Soft Cores, IP Engine , IP 
Evaluation Kit, IP Factory, IP -PCB, IP QuickUse, IPSim, IS_Analyzer, IS_Floorplanner, IS_MultiBoard, IS_Optimizer, IS_Synthesizer, ISD 
Creation(SM), ITK, It's More than Just Tools(SM), Knowledge Center(SM), Knowledge-Sourcing(SM), LAYOUT, LNL, LBIST, LBISTArchitect, 
Language Neutral Licensing, Lc, Lcore, Leaf Cell Toolkit, Led, LED LAYOUT, Leonardo, LeonardoInsight, LeonardoSpectrum, LIBRARIAN, 
Library Builder, Logic Analyzer on a Chip(SM), Logic Builder, Logical Cable, LogicLib, logio, Lsim, Lsim DSM, Lsim-Gate, Lsim Net, Lsim 
Power Analyst, Lsim-Review, Lsim-Switch, Lsim-XL, Mach PA, Mach TA, Manufacture View, Manufacturing Advisor, Manufacturing Cable, 
MaskCompose, MaskPE, MBIST, MBISTArchitect, MCM Designer, MCM Station, MDV, MegaFunction, Memory Builder, Memory Builder 
Conductor, Memory Builder Mozart, Memory Designer, Memory Model Builder, Mentor, Mentor Graphics, Mentor Graphics Support CD(SM), Mentor 
Graphics SupportBulletin(SM), Mentor Graphics SupportCenter(SM), Mentor Graphics SupportFax(SM), Mentor Graphics SupportNet-Email(SM), Mentor Graphics 
SupportNet-FTP(SM), Mentor Graphics SupportNet-Telnet(SM), Mentor Graphics We Mean Business, MicroPlan, MicroRoute, Microtec, Mixed-Signal 
Pro, ModelEditor, ModelSim, ModelSim LNL, ModelSim VHDL, ModelSim VLOG, ModelSim SE, ModelStation, Model Technology, 
ModelViewer, ModelViewerPlus, MODGEN, Monet, Mslab, Msview, MS Analyzer, MS Architect, MS-Express, MSIMON, MTPI(SM), 
Nanokernel, NetCheck, NETED, OpenDoor(SM), Opsim, OutNet, P&RIntegrator, PACKAGE, PARADE, ParallelRoute-Autocells, ParallelRoute-
MicroRoute, PathLink, Parts SpeciaList, PCB-Gen, PCB-Generator, PCB IGES, PCB Mechanical Interface, PDLSim, Personal Learning Program, 
Physical Cable, Physical Test Manager:SITE, PLA Lcompiler, Platform Express, PLDSynthesis, PLDSynthesis II, Power Analyst, PowerAnalyst 
Station, Power To Create, Precision, Precision Synthesis, Precision HLS, Precision PNR, Precision PTC, Pre-Silicon, ProjectXpert, ProtoBoard, 
ProtoView, QNet, QualityIBIS, QuickCheck, QuickConnect, QuickFault, QuickGrade, QuickHDL, QuickHDL Express, QuickHDL Pro, 
QuickPart Builder, QuickPart Tables, QuickParts, QuickPath, QuickSim, QuickSimII, QuickStart, QuickUse, QuickVHDL, RAM Lcompiler, RC-
Delay, RC-Reduction, RapidExpert, REAL Time Solutions!, Registrar, Reinstatement 2000(SM), Reliability Advisor, Reliability Manager, REMEDI, 
Renoir, RF Architect, RF Gateway, RISE, ROM Lcompiler, RTL X-Press, Satellite PCB Station, ScalableModels, Scaleable Verification, SCAP, 
Scan-Sequential, Scepter, Scepter DFF, Schematic View Compiler, SVC, Schemgen, SDF (Software Data Formatter), SDL2000 Lcompiler, Seamless, 
Seamless C-Bridge, Seamless Co-Designer, Seamless CVE, Seamless Express, Selective Promotion, SignaMask OPC, Signal Spy, Signal Vision, 
Signature Synthesis, Simulation Manager, SimExpress, SimPilot, SimView, SiteLine2000(SM), SmartMask, SmartParts, SmartRouter, SmartScripts, 
Smartshape, SNX, SneakPath Analyzer, SOS Initiative, Source Explorer, SpeedGate, SpiceNet, SST Velocity, Standard Power Model Format 
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Altera is a registered trademark of Altera Corp.
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Apple and Laserwriter are registered trademarks of Apple Computer, Inc.

ARIES is a registered trademark of Aries Technology.
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Thumb are trademarks or registered trademarks of ARM Limited.
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VHDeLDO and Xelga are registered trademarks of ANACAD Electrical Engineering Software, a unit of Mentor Graphics Corporation.

AVR is a registered trademark of Atmel Corporation.

CAE+Plus and ArchGen are registered trademarks of CAE Plus, Inc.

CalComp is a registered trademark of CalComp, Inc.

Canon is a registered trademark of Canon, Inc. BJ-130, BJ-130e, BJ-330, and Bubble Jet are trademarks of Canon, Inc.

Centronics is a registered trademark of Centronics Data Computer Corporation.

ColdFire and M-Core are registered trademarks of Motorola, Inc.

Design Planner, HLD Systems, Logic DP, Physical DP, and Pillar are trademarks or registered trademarks of High Level Design Systems.

Ethernet is a registered trademark of Xerox Corporation.

Foresight and Foresight Co-Designer are trademarks of Nu Thena Systems, Inc.

FLEXlm is a trademark of Globetrotter Software, Inc.

GenCAD is a trademark of Mitron Corporation.

Hewlett-Packard (HP), LaserJet, MDS, HP-UX, PA-RISC, APOLLO, DOMAIN and HPare registered trademarks of Hewlett-Packard Company.

HCL-eXceed and HCL-eXceed/W are registered trademark of Hummingbird Communications. Ltd.

HSPICE is a registered trademark of Meta-Software, Inc.

Installshield is a registered trademark and service mark of InstallShield Corporation.

IBM, PowerPC, and RISC Systems/6000 are trademarks of International Business Machines Corporation.

I-DEAS Harness Design is a registered trademark of Structural Dynamics Research Corporation.

IKON is a trademark of IKON Corporation.

IKOS and Voyager are registered trademarks of IKOS Systems, Inc.

Imagen, QMS, QMS-PS 820, Innovator, and Real Time Rasterization are registered trademarks of QMS Corporation.   imPRESS and UltraScript are 
trademarks of QMS Corporation.

Infineon, TriCore, and C165 are trademarks of Infineon Technologies AG.

Intel, i960, i386, and i486 are registered trademarks of Intel Corporation.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems, Inc.

Linux is a registered trademark of Linus Torvalds.

LM-family and SmartModel are registered trademarks of Logic Modeling Corporation. Speed-Model and Speed Modeling are trademarks of Logic Modeling 
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MACH, XP, and Zycad are trademarks of Zycad Corporation.

MemoryModeler MemMaker are trademarks of Denali Software, Inc.

MIPS is a trademark of MIPS Technologies, Inc.

Motif and OSF/Motif are trademarks of Open Software Foundation, Inc.

MS-DOS, Windows 95, Windows 98, Windows 2000, and Windows NT are registered trademarks of Microsoft Corporation.

MULTI is a registered trademark of Green Hills Software, Inc.

NEC and NEC EWS4800 are trademarks of NEC Corp.
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PKZIP is a registered trademark of PKWARE, Inc.

PADS-Perform is a registered trademark of PADS Software, Inc.

Pro/Cabling is a registered trademark of Parametric Technology Corporation.

Quantic is a registered trademark of Quantic Laboratories, Inc. 
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Red Hat is a registered trademark of Red Hat Software, Inc.
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SPARC is a registered trademark, and SPARCstation is a trademark, of SPARC International, Inc.

Spectre and SpectreRF are registered trademarks of Cadence Design Systems, Inc.

Sun Microsystems, Sun Workstation, and NeWS are registered trademarks of Sun Microsystems, Inc. Sun, Sun-2, Sun-3, Sun-4, OpenWindows, SunOS, 
SunView, NFS, and NSE are trademarks of Sun Microsystems, Inc.

SuperH is a trademark of Hitachi, Ltd.

Synopsys, Design Compiler, Library Compiler, PrimeTime and Chronologic VCS are trademarks or registered trademark of Synopsys, Inc.

TASKING is a registered trademark of TASKING.

Teamwork is a registered trademark of Cadre Technologies, Inc.

Tensilica and Xtensa are trademarks of the Tensilica, Inc.

Times and Helvetica are registered trademarks of Linotype AG.

TimingDesigner, QuickBench, and Chronology, are registered trademarks of Chronology Corp.

Transmission Line Calculator (TLC), Crosstalk Toolkit (XTK), Crosstalk Field Solver (XFX), Pre-Route Delay Quantifier (PDQ), and Mentor Graphics Board 
Station Translator (MBX) are trademarks of Quad Design.

Tri-State, Tri-State Logic, tri-state, and tri-state logic are registered trademarks of National Semiconductor Corporation.

UG Wiring is a registered trademark of Unigraphics Solutions, Inc.

UNIX and OPEN LOOK are registered trademarks of UNIX System Laboratories, Inc.

Versatec is a trademark of Xerox Engineering Systems, Inc.

ViewDraw, Powerview, Motive, and Viewlogic are registered trademarks of Viewlogic Systems, Inc.

Visula is a registered trademark of Zuken-Redac.

VxSim, VxWorks and Wind River Systems are trademarks or registered trademarks of Wind River Systems, Inc.

Z80 is a registered trademark of Zilog, Inc.

ZSP and ZSP400 are trademarks of LSI Logic Corporation.

XVision is a registered trademark of Visionware Limited, a subsidiary of the Santa Cruz Operation, Inc. 

X Window System is a trademark of MIT (Massachusetts Institute of Technology).
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